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Figure 2. Schematic showing the steps to alter the cholesterol levels in Drosophila S2 cells. 

Cyclodextrins (methyl-β cyclodextrin) were used to reduce the concentration of cholesterol 

in live cells, followed by addition of cholesterol (Chol-mβCD) to the growth medium to 

restore cholesterol levels. In each cell population, integrin microclustering and lipid diffusion 

were measured with FRET and FRAP, respectively. 
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Figure 3. Graph of the amount of cholesterol measured per cell in three cell populations 

(black) untreated cells before cholesterol reduction; (white) after reduction with mβCD to 

extract cholesterol; and (dashed) after adding chol-mβCD to the growth medium to restore 

cholesterol levels. Error bars represents three replicate experiments. Details of the cell lines 

are found in the text.  
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Figure 4. Graph of the amount of cholesterol measured per βV409D integrin expressing 

cell after adding additional cholesterol to the growth medium.  The basal concentration of 

cholesterol in the growth medium is 45 µM. Error bars represents three replicate 

experiments. 
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Supplementary Figure S1. Chromatogram of lipid extract from transformed Drosophila S2 

cells. Traces represent lipid extract from cells and lipid extract spiked with a cholesterol 

standard. Lipid extracts obtained with the Bligh-Dyer method, were analyzed using High 

Performance Liquid Chromatography (HPLC) with a UV-Vis detector (Agilent, USA). A 

reverse phase C-18 column (ZORBAX Eclipse XDB-C18, 4.6x150mm, 5 µm) was used with 

a flow rate of 1.0 ml/min. The absorbance was monitored at 205 nm wavelength. The mobile 

phase solvents consisted of 3 % water and the remaining 97% consisted of   

acetonitrile/methanol (50/50, v/v). 5 µL of the lipid extract was injected into the column.  
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Supplementary Figure S2. Calibration curve obtained using an Amplex red assay and 

cholesterol standards. Error bars represent three replicate experiments.  
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Supplementary Figure S3. Example of FRAP curve showing the changes in fluorescence 

intensity for the photobleached spot (triangles) on membrane of cells expressing wild-type 

integrins.  Carbocyanine DiD is used to dye the membrane. Initial four data points represent 

pre-photobleached spot. Approximately 70% decrease in fluorescence intensity is observed 

immediately after photobleaching. Over time the photobleached spot is repopulated with 

unbleached DiD dye molecules and full recovery is begins within ~6 seconds of 

photobleaching. The difference between recovered and the pre-bleached intensity shows a 

~20% immobile fraction within the membrane. The experimental data was fitted to an 

exponential curve. The dotted lines is plotted to obtain the time at which the 50% of the 

recovery was achieved, which is used to calculate the diffusion coefficient.  
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CHAPTER 4: GENERAL CONCLUSIONS AND FUTURE PROSPECTS 

 

GENERAL CONCLUSIONS 

Currently, few analytical techniques can measure nanoscale events in an in-vivo 

environment leading to a better understanding of the organization of the cell membrane. The 

work presented in this thesis describes how intracellular signaling events can be measured by 

coupling the FRET and RNAi techniques. The ability to measure intracellular signaling 

events opens the way to further investigate other signaling pathways using this approach. 

Also, the dissertation describes how cholesterol sequestration is combined with FRET to 

deduce the role of cholesterol in the cell signaling.  

The second chapter focuses on combining FRET with RNAi to measure integrin 

microclustering without altering the integrin dynamics. The data presented herein revealed 

that four cytoplasmic proteins involved in connecting integrins with the actin cytoskeleton 

also affect integrin microclustering when extracellular signaling events are minimal. The 

results also indicated that αβV409D mutant integrin is more sensitive to interactions linking 

integrins to receptor tyrosine kinases (RTK) compared to wild-type integrins. For alpha 

cytoplasmic mutation (anaβ integrins), the data indicated no change in microclustering 

when expression of all the cytoplasmic proteins except paxillin is reduced. 

The data reported in chapter three elucidates the role of cholesterol in integrin 

microclustering. This study reports the alterations in integrin microclustering in response to 

cholesterol depletion and restoration. Quantitative changes in integrin microclustering and 

lipid diffusion are measured when more than 40% membrane cholesterol is depleted. More 

than 20% increase in lipid diffusion, at reduced cholesterol levels, was observed for the cells 
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expressing wild-type or mutant integrins. Upon cholesterol depletion, maximum change in 

lipid diffusion and energy transfer is observed for cells expressing αβV409D integrins, which 

have the highest ligand affinity of the three integrins studied here. The reversibility of the 

process was assessed by reintroducing cholesterol in the cholesterol depleted cells. Both the 

lipid diffusion and the integrin microclustering are restored in the cells expressing the 

αβV409D integrins, indicating the measured changes are cholesterol dependent. Because of 

the limited uptake of cholesterol by S2 cells, measuring integrin microclustering under more 

than normal cholesterol levels were not possible.  

FUTURE PROSPECTS 

The scope of the developed method described in this dissertation is not just limited to 

measuring integrin microclustering under altered levels of cholesterol and cytoplasmic 

proteins. The method demonstrated herein can be applied in many different combinations to 

determine various factors that affect integrin microclustering.  

Previous studies by Smith et al. showed the dependence of αβV409D mutant integrin 

microclustering on the presence of other membrane proteins.
1
 In Chapter 2 (Figure 4) the 

FRET results for αβV409D mutant revealed that the receptor tyrosine kinase (RTK) can 

possible affect integrin function. This FRET data can be used as a preliminary evidence to 

target the RTK, using RNAi, and measure the subsequent changes in integrin 

microclustering. Another membrane protein that can be studied is insulin like receptor (InR), 

which has been previously shown to be associated with integrins and are natively expressed 

in S2 cells.
2
 A class of membrane proteins called tetraspanins is known to interact with the 

alpha subunit of integrins and also forms web like complexes among themselves and with 
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integrins.
3
 Studying the integrin function under reduced expression of one or more 

tetraspanins can provide useful insights into the interplay between integrins and tetraspanins.  

The method can be further extended to observe the changes in integrin 

microclustering under the simultaneous reduced expression of both the membrane proteins 

and cytoplasmic proteins. Based on this thesis finding and a known previous relationship 

between DOCK and RTK, valuable information can be obtained by targeting DOCK and 

RTK simultaneously and measuring the αβV409D mutant integrin microclustering.  

As an extension to the approach presented in this dissertation, coupling the three 

techniques FRET assay, RNAi technique and cholesterol sequestration can unravel complex 

interactions between the integrins and other cellular components. Additionally, a more 

complex connection can be made between intracellular signaling events and extracellular 

signaling events by performing the experiments in chapter 2 at high ligand density.  

Integrins are not the only class of receptors that can be studied using the FRET 

reporters. Other receptors can also be studied using appropriately designed FRET reporters. 

A good choice will be an important class of receptors called EGFR. 
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APPENDIX I: Statistical Analysis of FRET and FRAP data 

Deepak Dibya and Emily A. Smith 

 

 In order to statistically analyze the skewed data, the data can be reduced by 

transforming the data thereby reducing the skewness. The mathematical transformations that 

can be applied to the data include square root, reciprocal, logarithm etc. If a transformation is 

used, it is important to check whether the normal distribution of the data is achieved after the 

transformation or not.  

 All the FRET and the FRAP data presented in this dissertation has been statistically 

analyzed using the application JMP 7 (SAS Institute Inc, Cary, USA), with statistical 

consulting through the Iowa State University Department of Statistics. An example of the 

statistical analysis of the FRET data is presented in this appendix.   

 Open the JMP 7.0 program and follow the steps to statistically analyze the data.  

1. File>New>Data table 
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2. Select Cols>Add New Column. The next window prompts to name the new 

column and provide column characteristics. Ensure that the data type is set to 

numeric and Modeling is continuous.  

 

3. Double click on Column 1. Change the data type to character and 

modeling type to Nominal.  

 

4. After assigning the modeling types to the columns, begin data analysis by pasting the 

data in Column 2; one data set followed by the other. Column 1 contains the 

information given by data in Column 2, where control and experiment are 

represented by 0 and 1 in Column 1 respectively. The cells in the columns with dots 

showing no data are not included when analyzing the data.  
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5. The normal distribution of the data can be determined by using the menu function 

Analyze>Distribution and selecting Column 1 as By and data columns as 

Y, Columns. 

                             

           

6. The distribution function shows that the raw data is not normally distributed (Figure 

1, Column 2) which means statistical tests like t-test cannot be utilized for data 

analysis. The normal distribution was achieved by taking the natural log of the raw 
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data (Figure 1, Column 3), and the means were compared using Welch’s t-test on the 

transformed data.  

                           

Figure 1. Distribution of raw data  (column 2) and log transformed data (column 3) 

 

7. In order to perform t-test, select Analyze>Fit X by Y and use Column 1 as X 

factor and data sets as Y, Response. Click on the small red triangle at the 

corner of the plot, then select UnEqual Variances  
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8. This (as shown in figure below) presents the results of statistical analysis that can 

now be used to interpret the data.   

 

 The Welch t-test is a modification of the student t-test and does not assume equal 

variances. Results of the Welch t-test are reported as p-values. A p-value of less than 0.05 

suggests that the two means are different. Moreover, a p-value of more than 0.05 does not 

indicate that the two means are same. It means that there is not enough statistical 

evidence to show that the two means are different. Two means with a p-value of greater 

than 0.05 can be statistically different if the sample size under analysis was too small or 

the null hypothesis is really true. This would require advance statistical analysis of the 

data.  
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APPENDIX II: Expression, Purification and Estimation of Taq DNA 

Polymerase 

Deepak Dibya and Emily A. Smith 

 

INTRODUCTION 

 Polymerase chain reaction (PCR) is a well known reaction invented by Kary Mullis in 

1985 for the in-vitro amplification of DNA sequences. Figure below shows how this 

technique can be utilized in making large number of copies of a gene from a template DNA. 

 

 

      Adapted from the homepage of Andy Vierstraete 

 

 There are several chemicals and enzymes required to complete the PCR. One of the 

key components in duplicating DNA sequences in PCR is an enzyme called Taq polymerase. 

This enzyme has been isolated previously and is widely used in PCR based applications. Taq 
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polymerase is a thermostable enzyme and can survive the temperature fluctuations involved 

in PCR. The enzyme participates in a template directed syntheses of DNA fragments and 

requires free Mg
2+

 for its optimum functioning.  

 The protocol for making Taq polymerase is well developed and is routinely used in 

academia and industry to express and purify the enzyme. Since commercial Taq polymerase 

is expensive, Taq polymerase was prepared in Smith group at Iowa State University  

 

EXPERIMENTAL 

 Taq polymerase synthesis is a four step process. First, bacterial cell culture media is 

prepared to grow DH5α E.coli cells that contains plasmid specific for Taq polymerase. The 

second step involves the expression of Taq polymerase in the confluent cell culture by 

chemical induction. This is followed by purification of the enzyme. Finally the efficacy of 

the purified enzyme is validated by performing a PCR reaction and analyzing the PCR 

products in on a agarose gel electrophoresis. Also, the efficiency of the enzyme is compared 

with commercially available enzyme and an optimum amount of enzyme is estimated to 

conduct future PCR reactions.  

 

Preparation of terrific broth (media) 

 Taq polymerase was purified from DH5α E.coli cells expressing the inserted plasmid 

specific for Taq polymerase. The cells were grown in terrific broth media. To make terrific 
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broth media,12 g bactotryptone, 24 g yeast extract and 4 mL glycerol were dissolved in 900 

mL water and sterilized. To this sterilized solution, 100 mL sterile solution of 0.17 M 

KH2PO4 and 0.72 M K2HPO4 was added. Antibiotic used for pTaq was ampicillin. 

Ampicillin was not added to the entire solution but to only that portion of the media that was 

used for growing cells. 

 

Expression of Taq polymerase 

 1.0 µL of 50 mg/mL ampicillin solution was added to 1.0 mL of the terrific broth 

media. The media was inoculated with DH5α E. coli cells and incubated overnight at 37C. 

100 µl of this culture was used to inoculate a fresh 1.0 mL culture media containing 1.0 µL 

of 50 mg/mL ampicillin. It was then followed by incubation for 90 min at 37C. This culture 

was transferred to a 100 mL fresh culture media (pre-warmed to 37C in an incubator) 

containing 100 µL of 50 mg/mL ampicillin. The above culture was incubated at 37C until an 

OD600 of 0.3 and then induced with 25 µL of 2.0 M IPTG. The culture was again incubated 

for 16 hours at 37C and then centrifuged at 5000 rpm for 5 minutes to obtain a pellet of 

cells.  

 

Purification of Taq polymerase 

 The pellet obtained from the culture was resuspended in 3 mL of Buffer A (50 mM 

Tris pH 7.9, 50 mM dextrose,1.0 mM EDTA, 4mg/mL lysosyme) and incubated for 15 min 
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at room temperature. To this was added 3.0 mL of buffer B (10.0 mM Tris pH 7.0, 50 mM 

KCl, 1.0 mM EDTA, 0.5% Tween20, 0.5% Noni P40) and the solution was incubated for 60 

min at 75C with shaking. It was followed by centrifugation at 10000 rpm for 10 minutes to 

remove cell debris and denatured protein. The lysate was mixed with an equal volume of 

storage buffer (50 mM Tris pH 8.0, 100 mM NaCl, 0.1 mM EDTA, 0.5 mM Dithiothreitol 

(DTT) and 1% triton X-100) containing 50% glycerol. Equal volume of storage buffer 

containing 75% glycerol was again added. The resulting solution contained Taq polymerase, 

which was aliquoted and stored at -20C.  

RESULTS 

 Efficiency of the purified Taq polymerase (in-house) was verified by performing a 

PCR reaction and analyzing the PCR products on a 1% agarose gel electrophoresis. Serial 

dilution of the enzyme was used to establish an optimum volume of in-house Taq polymerase 

to be used for future PCR reactions. The in-house Taq was also compared with the 

Figure 1. Gel electrophoresis of PCR products  

Lane 1: Marker (ladder) lane 

Lane 2-5: Higher to lower amounts of commercial Taq 

Lane 6: Control (no Taq used in the PCR ) 

Lane 7-10: Higher to lower amounts of in-house Taq 
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commercially available Taq to estimate the amount of in-house Taq that will be needed for 

conducting PCR reactions successfully in future. Figure above is an agarose gel 

electrophoresis image showing the DNA fragments amplified by PCR using commercial Taq 

(Takara, WI) and in-house Taq.  
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 APPENDIX III: Synthesis of double stranded RNA 

 

Deepak Dibya and Emily A. Smith 

 

INTRODUCTION 

 Double stranded RNA (dsRNA) was synthesized using the DNA sequences that 

correspond to the proteins targeted in Chapter 2. In brief, DNA sequences from S2 genomic 

DNA were amplified using polymerase chain reaction (PCR). The DNA amplicons were 

used as templates for single-stranded RNA (ssRNA) syntheses using MEGASCRIPT T7 

Transcription Kit (Ambion, Austin, TX). ssRNA was purified by ethanol-precipitation, 

followed by the formation of dsRNA. The concentration of ssRNA was measured using UV-

Vis spectrophotometry. The dsRNA products were also analyzed with 1% agarose gel 

electrophoresis. 

 The enzyme that catalyzes the formation of ssRNA in the 5'→ 3' direction is called 

T7 RNA polymerase. T7 RNA polymerase is extremely promoter-specific and only 

transcribes DNA cloned downstream of a T7 promoter region. The source of the enzyme is 

the T7 bacteriophage, a virus that infects only bacteria, and has been found to have a very 

low error rate. The molecular weight of this enzyme is 99kDa. In biotechnology applications, 

T7 RNA polymerase is commonly used to transcribe a DNA template into a ssRNA. The T7 
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promoter sequence used in all the primers herein is TAATACGACTCACTATAGGG. This 

T7 sequence was prefaced to every RNAi probe (forward and reverse primer sequence) that 

was used to target cytoplasmic proteins. Details of the RNAi probes used in synthesizing 

dsRNA are given in Table 1. 

Table 1. RNAi probes. The letters F an R in the parentheses denote forward and reverse 

primers respectively. 

Protein Probe ID Probe Length Primer Sequence 

Rhea (F) 
HFA11300 507 

CGCCGATCCAGGTCAAC 

Rhea (R) ATCATTTGCGGCTTAGTAGA 

FAK (F) 
BKN21731 529 

TGATTGAACCTTGCACCAAA 

FAK (R) AACCAGGTCGACAAACGAAC 

Paxillin (F) 
BKN29242 313 

TGTGGGATTGGGTCGTAAAT 

Paxillin (R) CCTTCTTTGATCACGAGGG 

Vinculin (F) 
HFA18728 513 

CTTCAGCACCCGGAAATC 

Vinculin (R) GCGACCAGCGCTGATAA 

Dreadlock (F) 
HFA00812 440 

TGTACAGCTTCACGTCAAACAA 

Dreadlock (R) AGTCTCACTGTCTCTGATGAG 

Integrin linked kinase (F) 
HFA11868 489 

GGTAAACGAGCATGGAAACAC 

Integrin linked kinase(R) GAATTGCATGCTCCAATAATA 

Steamer Duck (F) 
HFA17070 269 

CTTCCAGGATGGGATATTC 

Steamer Duck (R) CATAGCGGCCGGTAATCT 

 

Further details of the RNAi probes such as efficiency and other target values are published 

elsewhere and can be obtained from the online resources: http://flyrnai.org 
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Concentration of DNA amplicons were estimated on a 1% agarose gel, using the intensity at 

500bp of the ladder sequences. This concentration was used to estimate the amount of 

amplicon to be used in the subsequent step of ssRNA synthesis. 

 

ssRNA synthesis 

 Enzyme mixture and the DNA amplicons were thawed on ice. 10X buffer provided in 

the kit was thawed at room temperature. The four nucleotides were thawed at room 

temperature and then put on ice. Table 3 shows the reaction mixture for synthesizing ssRNA 

for a cytoplasmic protein. The strategies described here were used in synthesizing ssRNA of 

all the seven cytoplasmic proteins targeted, as described in chapter 2. In Table 3, the contents 

in a 1.7 mL centrifuge tube were mixed by vortexing and combined in the order from top to 

bottom. Total volume of the reaction was kept at 20 µL. 

Table 3. The reaction mixture for the synthesis of ssRNA. Master mix is the solution 

obtained by mixing equal amount of each of the nucleotides (U,A,G,C). 

 

Reaction 

Components 

Cytoplasmic 

Proteins 

Control 

Nucleotides 

(from master mix) 

8 µL 8 µL 

10 X buffer 2 µL 2 µL 

DNA amplicon 8 µL - 

Enzyme (Ambion) 2 µL 2 µL 

water - 8 µL 

Total Volume 20 µL 20 µL 
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 The reaction mixture was incubated in a dry bath (should contain water) at 37 C for 

6 hours to overnight. After incubation, the solution volume was brought to 300µL by adding 

240 µL of sterile water and 40 µL of 3.0 M sodium acetate (pH 5.2). Then 700µL of 200 

proof ethanol was added. The contents were mixed and the tubes were kept in the freezer for 

at least 30 min and then centrifuged at the maximum speed (15,000 rpm) for 15 minutes at 4 

C. The supernatant was removed by decanting, followed by addition of 1 mL of 70% ice-

cold ethanol. Again, the tubes were centrifuged at maximum speed for 15 min at 4 C and the 

supernatant was removed. The resulting ssRNA pellet was resuspended in 50 µL of sterile 

water. At this time, the ssRNA is very susceptible to degradation; therefore the next steps 

should be done in quick succession. 

 For the UV-Vis measurement, 2.0 µL of the above ethanol precipitated ssRNA was 

diluted by adding 2.0 µL of the ssRNA to 348 µL of sterile water. Prior to the UV-Vis 

absorbance measurements, dsRNA was generated from the ssRNA by incubating the 

remaining ssRNA solution (48 µL) in the dry bath at 65°C for 30 min. After 30 min the metal 

holder containing the dsRNA centrifuge tube was taken out and allowed to cool at room 

temperature. During 30 min of dsRNA formation, absorbance measurements at 280 nm were 

taken and the concentration of the ssRNA was obtained. dsRNA solution was then diluted 

with sterile water to a final concentration of 1.0 µg/µL. This solution was analyzed on a 1% 

agarose gel to ensure that the dsRNA contained the desired number of base pairs. The 

dsRNA solution was stored at -20°C for future use. 
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